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Introduction 
Inkscape is an open-source vector drawing program and is equivalent to commercial 
packages such as Adobe Illustrator or Deneba Canvas. The current version is 0.48 and it is 
constantly being developed and upgraded. The project website includes tutorials, guides 
and forums and can be found here: www.inkscape.org.  
  
Vector graphics are images are made up of a set of objects, usually a set of joined lines or 
curves which are defined by a series of points (nodes) or a path. This is in contrast to 
conventional bitmap images which are defined by a set of pixels. Vector drawing facilitates 
the creation of extremely high quality images, with little pixelation and very small file sizes. 
It also allows you to easily manipulate and adjust all aspects of an illustration quickly i.e. It 's 
a fast, flexible and very high quality drawing environment.  As most word processing 
software isn't yet setup to accept vector images, we usually export them as a bitmap at a 
high resolution so that we can use them in other programs.   
  
How to get the most out of inkscape: 
  

• If you are not an artist you need to know what you want to draw, have a sketch, a 
photo or an existing illustration on paper beside you as a rough reference.  

• Learn and use the inkscape shortcuts from the start (the "Ctrl" key is your friend!), it 
will speed the drawing process up hugely, there a few key shortcuts which we will 
cover.  Practising using them. 

• Like any piece of software, the more you use it the more useful it will become, so 
start working with it as soon as you can for work projects. Think about illustrations 
you might want/need for your thesis or a poster presentation or a group meeting. 

•  Create re-usable diagrams that describe the fundamental principles of your PhD and 
use it again and again.  

  
Who should use it:  
 
Anybody who needs to create high quality visuals for any discipline. Vector drawings are 
built from the bottom up as a series of objects so you can create any drawing and 
manipulate it in many ways.   
  
 
 
 
 
 
 
 
 
 
 
  

http://www.inkscape.org/�
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Overview of the user interface 
  

1. The Global toolbar 
 

  
Contains menu lists for major features of Inkscape  
• File ->   

o Open (Ctrl + O) 
o Save (Ctrl + S) 
o  Print (Ctrl + P) 
o  Import Image, 
o  Export Bitmap  (Shift + Ctrl + E)*,  
o  Document properties  (Shift + Ctrl + D)* 

 
• Edit->   

o Copy (Ctrl + C),  
o Paste (Ctrl + V),  
o Undo (Ctrl + Z),   
o Redo (Shift + Ctrl +Z),  
o Duplicate (Ctrl + D)* 
o Clone (Alt + D)* 

 
• View ->  

o Zoom : in ('+' key), out ('-' key)* 
o Show/Hide - configure which toolbars are viewable on the user interface. 

 
• Layer-> move and configure layers (not necessary for this tutorial, feel free to explore 

later) 
 

• Object**-> 
o Open the fill and stroke window (Ctrl + Shift + F)*  

- edit the outline (stroke) and colour (fill) of your objects 
 

o Group (Ctrl + G)*, Ungroup (Ctrl + U)* or (Shift + Ctrl + G) 
o Raise (PgUp)*,  Lower (PgDn)* 

- raise or lowers and object in relation to other objects.  

 
o Rotate objects 
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o Open the Transform window  (Ctrl + Shift + M)* 
o Open the Align and Distribute window (Ctrl + Shift + A)** 
o Rows and Columns  

- not needed for this tutorial 
  
• Path -> Very powerful options for editing, vectors (lines and nodes) beyond the scope of 

this tutorial, look into it a later stage. 
 
• Text->  

o Open the text and font window (Ctrl + Shift + T) or by clicking  

•  

•  
• Filters - > Artistic effects, beyond the scope of this tutorial and a little unstable.  
• Extensions - > Beyond the scope of this tutorial and a little unstable.  
• Help -> Very good tutorials and information as well as link to online forums - use as 

much as possible.  
  
  

2. The Shortcuts toolbar  

 
  

3. The Tool Command toolbar 
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4. The Toolbox Sidebar 

 
  

5. The Object Palette (bottom of the screen) 

 
  
When you have one or more objects selected, use the object palette to quickly select the fill 
colour (click directly on the colour) or the outline /stroke colour (Hold "shift" + click on the 
colour).   
 
 *Note: the help bar (“No objects selected”.), gives very useful tips on how to edit a 
selected object.  
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Exercise 1: Creating and Editing Basic Objects 

 Setup your document: 
1. Create a new document by selecting :  File -> new -> A4.   
2. Edit the document properties by selecting : File-> Document Properties  or (using Ctrl + 

Shift +D) 
3. In the document properties window:  

a. Change the background colour from transparent to fully white (for compatibility 
with other programs) 

b. Change units to mm 
c. Make sure the sheet is A4, portrait.  
d. Close the Document Properties window  

4. Check that the zoom level is ok on your document by using the '+' and '-' keys (or by 
holding Ctrl and scrolling the mouse wheel). Zoom to your preferred level. This is 
essential for fine editing of nodes. 

 

Create Objects using the toolbox sidebar: 
1. Rectangles & Squares: 

a. Select the square icon from the toolbox side bar:  

b. On your drawing sheet, click and drag the mouse cursor to create a rectangle.  
c. (To restrict the ratio of the rectangular sides, hold 'Ctrl' and click and drag, use 

this to create squares).  
d. Resize the rectangle by double clicking it (this enters edit 

mode for most objects) and clicking and dragging on  
the square points on  
it's top left, or bottom  
right corners.  

e. Round the edges of the rectangle by double clicking on it (edit mode) and 
clicking and dragging on the circle(s) in the top-right corner of the rectangle.  

 
2. Ellipses and Circles: 

a. Select the circle and ellipses drawing icon from the toolbox sidebar:  
b. Click and drag in your document to create an ellipse. 
c. (To restrict the ratio of the ellipses' vertical and horizontal axis, hold 'Ctrl' and 

click and drag, use this to create circles) 
d. Resize the ellipse by double clicking 

 on it (edit mode) and clicking and dragging  
on it's square points (nodes)located at it's "9 o'clock" 
and "12 o'clock points" . 

e. Create elliptical segments by clicking and dragging on the circle at its "3 o'clock".     
 
3. Draw Straight Lines and Curves (~this is a very useful for creating most irregular shapes 

and inkscape objects): 

a. Click on the line drawing icon on the toolbox sidebar:  
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b. Click once on the document to create the first point (node) for your line/curve.  
c. Drag the cursor and click again to create the second point /node on your line or 

curve and continue to create 5 more nodes 
d. When you want to stop drawing/adding nodes, double click to create the last 

node and exit the line drawing mode.  
e. To edit your line (like all objects), double click on it using the selector tool (not 

the drawing tool):  

f. You can also edit your line (or any other objects) using the edit paths tool:   
 

4. Edit Objects using the edit paths tool : 
a. Any object can be edit using the edit paths tool, double clicking an object with 

the selector tool   usually enters this edit mode. 
b. To edit you line/curve, select a node using the edit paths tool and move it 

around.  
c. To make a curve from your line, click and drag the line with the edit paths tool 

until it bends. 
d. You will see circular tangent handles appear,  

 you can adjust the curvature of your line, 
 by clicking and dragging on these circular 
 tangent handles.  

  
  
5. Styling your Objects (Stroke and Fill) – N.B.*** 

a. Select the ellipse you create in step 2. 
b. You can quickly select a fill colour for any selected object by clicking on a colour 

from the object palette.  
c. You can quickly select an outline (stroke) colour for any selected object by 

holding "Shift" + clicking on any colour from the colour palette.  
d. To manipulate the stroke and fill of an object in more detail, open the stroke and 

fill window by clicking on the   icon in the shortcuts toolbar (or press Ctrl + 
Shift +F). The stroke and fill window should appear on the right. 
 

e. In the 'Fill' tab of the stroke and fill window select a flat fill   for the selected 
object (ellipse) and change the colour by dragging on the R,G or B bars

 

Fills: 

f. Adjust the opacity by dragging on the 'A' Bar. 
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g. Experiment with different fills by clicking on the no fill  , flat fill  , linear 

gradient  & radial gradient  icons.  You must have an object selected for 
this!!! 

 

h. In the stroke paint tab you can adjust the colour of the outline in the same way 
as the fill. Repeat the previous 3 steps to see this working.  

Stroke (lines and outlines) 

i. The stroke style tab allows you to choose the thickness and style of the outline, 
and also allows you to set start and end markers e.g. Create arrowheads on lines.  

 

j. Select the line/curve you created earlier in step 3 and 4 and experiment with 
its thickness, dashes and start and end markers in the stroke style tabs.  
 

6. Blur and Opacity 
At the bottom of the stroke and fill window is the blur and opacity controls for the 
selected object. Click and drag on these individually to adjust the blur and opacity of 
your object.  
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Exercise 2: Manipulating Objects: Duplicate, Clone, Select, 
Group, Move, Align, Distribute, Rotate and Flip.    
 

Duplicates vs. Clones 
1. Clear the drawing area by selecting all objects (or pressing Ctrl + A and then "Delete"). 
2. Create a new square as in step b-1  of the last exercise.  
3. Duplicate the square (press "Ctrl" + "D"), a duplicate now exists on top of the original 

and is selected.  
4. Click and drag the duplicate square to move it from the original square.   
5. Resize the original square as in step b-1-iii of the previous exercise, Does the copied 

square change?  
6. Delete the copied square.  
7. Clone the original square (press "Alt"+"D"), a clone now exists on top of the original 

and is selected.  
8. Click and drag the duplicate square to move it from the original square.   
9. Resize the original square as in step b-1-iii of the previous exercise, Does the copied 

square change?  
10. Why does it change - clones, are linked to their source object, and will change when 

changes are made to the source.  
11. Unlink the clone (press "Shift"+ "Alt"+"D"). And resize the source object, does the clone 

change now? 
  
Note: copying (Ctrl + C) and pasting (Ctrl + V) also works in Inkscape and is equivalent to 
a duplicate command. 

  

Selecting & Grouping 
1. Create 3 duplicates of the original square (4 squares in total).   
2. Select all three by clicking and dragging the select tool   or by holding "Shift" and 

clicking on the four squares.   
3. Group the squares by pressing ("Ctrl" + G). They can now be moved and treated as a 

single object (indicated by a single dashed box around the four squares. Click and drag 
them.  

4. UnGroup the squares by pressing ("Ctrl" + U). They can now be moved and treated as 
individual objects (indicated by 4 separate dashed boxes around each object). Click and 
drag them.   

  

Aligning and Distributing Objects 
1. Roughly arrange your four squares in a 

crooked line beside each other with some 
space between each.   

2.  Resize one square to be a taller and narrow 
than the others 
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3. In order to straighten these up we need to open the Align and Distribute window by 
pressing (Ctrl + Shift + A). 
 

4. Align: 
a. Align the bottoms of these objects by selecting all of the squares and clicking the          

 icon in the Align section of the Align and Distribute Window.  
b. Undo the last action by pressing Ctrl + Z. 
c. Align the tops of these objects by selecting all of the squares and clicking the 

icon in the Align section of the Align and Distribute Window.  
d. Undo the last action by pressing Ctrl + Z. 

e. Try aligning centring the squares on a common horizontal axis. By clicking the  

icon in the Align section of the Align and Distribute Window. 
 

5.  Distribute: 
a. Distribute/space the rectangles evenly using the Distribute section of the Align and 

Distribute window.  
b. Select the four rectangles again, create equal spacing between all of them by 

selecting the   icon in the Distribute section of the Align and distribute window. 
c. Hover the cursor over the other align and distribute Icons to get an idea of their 

function, experiment with different distributions, by roughly arranging the four 
rectangles, and re-aligning and distributing them, vertically and horizontally.    

  

Rotating, Flipping: 
a. Delete 3 of the four squares.  
b. Resize the remaining square to make it a tall, narrow rectangle. 
c. Rotate and flip the rectangle using the rotate object icons in the tool command 

toolbar: 
i. Rotate clockwise 90 deg.   

ii. Counter clockwise,  
iii. Flip vertical,  
iv. Flip horizontal.   
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Exercise 3: Creating a Block Diagram. 

 

 
  

1. Document setup (See the “Setup your Document” section, of pg 6): 
a. Setup a new sheet and set the document properties.  
b. Set the page orientation to landscape in the document properties window. 

 
2. Create your 1st block in the diagram (see “Rectangles and Squares” section of pg 6): 

a. Draw a rectangle that’s roughly twice as wide as it is high.  
b. Round the edges on the rectangle until it looks approximately like one of the 

rectangles in the above diagram. 
    

3. Adjust the fill and stroke of the block (see “Styling your Objects” section of pg 7): 
a. Give the rectangle a stroke width of 1mm  

b. Select a linear gradient fill  for the rectangle and give it a purple gradient 
background by dragging the R, B & A colour bars to the right (255) and the G bar 
to the left (0).  

c. Alternatively you can select a colour form the object palette tool bar, which will 
give you a flat fill, and just select the linear gradient fill button to create a colour 
gradient.  

d. Double click on the rectangle to edit the gradient by clicking and dragging the 
rectangular and circle nodes on either end of the gradient line (see figure below).  

  
e. Make the gradient diagonal as shown in the diagram, with colours fading, into 

the right bottom corner.  
f.  
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4. Clone (Alt+D) your rectangle(see pg 9): 
a. Clone the rectangle 6 times (7 rectangles in total) and arrange in a pyramid with 

three layers of 1, 2 and 4 rectangles (as in the figure at the top of 11).   
b.   Make sure your original rectangle is at the top of the pyramid. 

 
5. Align your blocks (See pg 9 & 10) 

a. Select your bottom four blocks and use the align and distribute window (Ctrl + 
Shift + A), to align their bottom lines.  

b. Make sure these four blocks are distributed evenly (equal space between the 
sides of adjacent rectangles by  using the appropriate distribute button) 

c. Group the two left most rectangles of the bottom four (group 1).  
d. Group the two right most rectangles of the bottom four (group 2).  

 
e. Select the group 1 object and vertically align it / centre on the vertical axis with 

the rectangle immediately above it.  
f. Select the group 2 object and vertically align it/ centre on the vertical axis with 

the rectangle immediately above it.  
 
The result should be as follows: 

 
The bottom 2 rows are now aligned but the top rectangle still needs to be centred. 

 
g. Select the six rectangles of the bottom 2 rows/tiers and group them. Now 

vertically align the top rectangle with this group of six.   
 

You should end up with the following: 
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Note: You can adjust the rectangle shape and size by editing the original rectangle (on 
top) at any stage, as the other 6 rectangles are clones they will also be identical to the 
original rectangle.  
 
 

6. Connect your blocks (pgs 6-8) 

a. You can connect objects very easily using the following line drawing tool  on 
the toolbox sidebar. 

b. Ungroup all of your objects by selecting all (Ctrl +A) and using the Ungroup 
command (Ctrl + U). 

c. Connect the rectangles as follows: keep the lines straight /at fixed angles by 
holding the Ctrl key while drawing.  

 

 
d. Select all of the lines (6 in total) and edit their stroke style to give them a stroke 

thickness of 0.7mm.  
e. With all of the lines still selected use the Start or end markers menu in the stroke 

style window to give the lines arrow heads (all pointing down) (Arrow1Mend 
should do the trick). This should give you: 
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7. Add a text object to your blocks by using the  tool. 
a. Click to create the object, and type to enter text.  
b. Enter text into each of the rectangles with a text size of approx 22 and centres 

aligned. (use the tool command toolbar to do this):

 
 

c. Enter the following text into each of the rectangles: 

  
 
8. Finally, create a glow to finish the illustration. 

a. Draw a large rectangle which covers your block diagram. 
b. Give it a green fill and a white stroke. 
c. Lower it below all the other object by pressing the End key 
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Exercise 4: Creating a Scientific Diagram (in 7 steps). 
  

 
  
 
  
Create the CCD sensor diagram by using the tools you have learned. The best way to start is 
to identify the individual objects in the diagram: 
 

   
 
A – Rectangles with a black fill create one and duplicate to create the second 
B -  A rectangle with a black gradient fill. 
C – A rectangle with a purple fill. 
D – Irregular shape – use the Bezier/line drawing tool to copy this shape, insert a circle and 
enclose it in a rectangle, duplicate it and flip it to create 2 opposing objects on either side of 
the CMOS imager. 
E – Create the lens shape using the Bezier tool to create a base line, and a curved line to 
create the semi-elliptical shape. Fill it with a blue linear gradient fill.  
F – Draw lines with the line drawing tool and add end markers to create arrow-head pointers.  
G – Add text using the text object tool.   
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